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Due: January 30, 2009 
 
Design Project 1 
This design project will serve as an introduction to CODE V and to familiarize you with generating and 
accessing data generated by CODE V for your design reports. A majority of this description is “cookbook” 
in nature just to get you initially started in using CODE V, but feel free to explore CODE V by clicking on 
the various menus, changing different parameters and doing a bunch of “what if’s.”  
 
Introduction to CODE V: Install CODE V Version 9.82 and familiarize yourself with the interface.  Also 
download the “CODE V Menus.pdf” from the OPTI340 website as a convenient reference for locating 
menu options. The full CODE V Reference Manual is available on-line under the Help menu. Specifically 
read the “Introductory User’s Guide” for an overview and brief description of CODE V and some of its 
capabilities. Also take a look at the “CODE V Test Drive” for a brief introduction to the basic operation and 
data manipulation within CODE V. 
 
Customizing the CODE V Interface:  Download the file “Tips for Customizing your Code V”, from the 
OPTI 340 website for instructions on customizing CODE V the interface to suit your personal preferences. 
The following customizations are highly recommended to make the design homework easier and the 
interface cleaner: 
 
Tools → Customize → Status Bar →  

 
 

Tools → Preferences → General →  

  



OPTI340, Spring 2009 
Design Project 1 

 2 

Saving Files:  When you install CODE V, a folder named “C:\CVUSER” is created. All of the files 
generated by CODE V will be saved in this folder. It is highly recommended that you take the time to save 
your files descriptively and keep each assignment in its own sub-folder. It is also recommended that you 
save your lens prescriptions as “sequence” (*.seq) files as opposed to “lens” (*.len) files. Sequence files are 
text files that are readable outside of CODE V as opposed to lens files which are binary files that are 
readable only by CODE V and can be version specific. For example, a lens file, test.len, created with 
CODE V 9.82 may not be readable by a future version of CODE V; however, the same lens saved as a 
sequence file, test.seq, is readable by past, present, and future versions of CODE V. 
 
 DesignProject_1a.seq  DesignProject_1a.len 
 DesignProject_1b.seq  DesignProject_1b.len 
 
In the example above, Design Project #1 consisted of part a and part b. For part a, the initial attempt was 
saved as DesignProject_1a, and then after optimizing or other tweaks, a different lens was generated and 
saved as DesignProject_1a.1. The next time this file is saved, it will be named DesignProject_1a.2, 
incremented by 1.  The most current file of DesignProject_1a is the file without the “.n”; the next most 
current file has the highest “.n”.  This way, you can track your design progression and can go back to a 
previous configuration.  It is important to note the standard restrictions on using special symbols in file 
names; in addition CODE V requires that any file names not have embedded spaces. 
 
Save all your work throughout the semester in C:\CVUSER directory. As you progress through this course, 
it may be useful to create sub-directories for each assignment or design problem. These sub-folders are 
created outside of CODE V in the Windows environment: 
 
 C:\CVUSER \DesignProject1 
 C:\CVUSER \DesignProject2 
 C:\CVUSER \DesignProject3 
 C:\CVUSER \DesignProject4 
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As we stated earlier, CODE V will initially start up in the C:\CVUSER directory, and all files created/saved 
during this session will be saved in this directory. To change the directory for the current session to an 
alternate directory, use the “cd” command in the “Command Window”: 
 

  
 
 CODE V> cd c:\CVUSER \DesignProblem1 
 
This command allows you to change the default directory for all input/output files for the current CODE V 
session. 
 
Turning in Design Homework:  All design homework must be submitted as a typed report including 
relevant plots, lens prescriptions and data so that we can tell what you did. This does not mean turning in 
every single plot, CODE V output and text file you find. Rather, present the information in well-organized 
tables and figures. You can highlight, copy, and paste only the necessary information from CODE V into 
your report. When you are designing, you should also be writing your report at the same time (at least 
collecting relevant CODE V generated data) by having CODE V and a word processing program open at 
the same time so you can switch between the two. Reduce the size of the CODE V plots in your reports to 
keep the number of pages reasonable. The font size can be small as long as it is readable. Just “copy” the 
active CODE V window and paste directly into Word. 
 
Another option for capturing zoomed plots is to use the “print screen” feature.  Make sure CODE V is 
displaying the figure you want to copy.  Hit the “print screen” button on the keyboard to copy the entire 
screen shown on the monitor.  From here, paste the figure into your word processor and edit as needed.
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Design Project 1 Homework: 
 
You will be examining a triplet lens using many automated features within CODE V. Not everything in this 
course will be this easy, but this example will get you through the basics of using CODE V even if you 
haven’t worked through the Test Drive. NOTE: underlined text highlights things that you are required to 
change in this lens for this Design Project. 
 
In order to restore a relevant lens example, use the “New Lens Wizzard”. From the “File” menu, select 
“New” to activate the “New Lens Wizzard”. 
 
Select “Next” to proceed to the next screen and highlight “CODE V Sample Lens” in response to “Where 
do you want to start from?” 
 
Scroll down to the last lens indicated in the displayed list “cvlens:triplet.len” and left click on its title to 
highlight. A layout of this lens is conveniently displayed.  Select “Next” to restore this lens.  
 
You have now restored a lens prescription for a triplet to CODE V from an internal lens database supplied 
with CODE V.  
 
Now modify various “system” parameters. 
 
The first screen allows you to define the “Pupil” characteristics of the lens system. If you recall from the 
previous menu, this triplet lens has an effective focal length of 100 mm and operates at F/3. Change the 
entrance pupil diameter value such that the lens will operate at F/8. 
 
On the next screen, change the spectral or wavelength characteristics to use the “Photopic(5 WL)” spectra: 
 
Click “Use Spectrum”. The following screen allows you to choose the “Reference Wavelength” or 
wavelength at which the first-order characteristics of the lens will be calculated.  Leave the reference 
wavelength as “W3- 542.02”. 
 
The default lens has three object angles currently defined: 0°, 14.0°, and 20.0°.  Insert two additional object 
angles for a total of five object angles.  This is done by left mouse clicking on any box to the right of the 
asterisk (*) line. Define the “Y Angles” for H= 0, 0.5, 0.7, 0.85, and 1.0, where the maximum semi-field 
object angle is 10.0˚. This will allow you to analyze the optical performance of the lens at five different 
field locations. 
 
The final screen saves the changes to the lens system and allows you to continue to operate CODE V. 
 
 
One of the first things I like to do is view a layout of the lens to see if its what I expect. The easiest way to 
accomplish this is to use the “Quick Analysis Buttons” located just below the menu titles: 
 
 Quick 2D – Labeled View Lens 
           Quick 3D Viewing    3D Viewing 

 
 
Alternatively, you can click on the “Display” menu and select “View Lens” to bring up a set of screens that 
allow you to modify various layout parameters for your lens. 
 
If you look closely at the layout of the lens, you’ll notice a couple of things that don’t look right. First, the 
first element’s edge is very thin, and the outermost field ray bundle propagates outside of the lens.  Second, 
the aperture stop is indicated by the ‘tic’ marks between lens elements 2 and 3. You will also note that the 
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marginal field rays don’t fully fill the aperture stop.  In a real lens, the marginal rays should encounter the 
edges of the aperture stop.  Recall that we defined the “Entrance Pupil Diameter” or EPD of this lens. 
CODE V has used this EPD to define the bundle of rays propagating through the lens at the five field 
angles you defined, irrespective of the physical apertures of the lens. Since we want to simulate the optical 
performance of a real lens, we want to tune our model accordingly by telling CODE V to “find the edges of 
the aperture stop and lens edges at all fields and use these rays to analyze the system.” However, before 
proceeding, let’s make the lens edges more realistic by defining vignetting apertures on the entering and 
exiting surfaces of the lens (Surfaces 1 and 7).  In the “Lens Data Manager” window, right click on the box 
that identifies the “Y Semi Aperture” of Surface 1, and left click the item “Change to circular aperture.” 
The box should now be white, indicating that the value can be modified. Change the semi-aperture of 
surface 1 to 15.0 mm. Using the same technique, also change the semi-aperture of surface 7 to 12.0 mm. 
Now clear and set the vignetting of the lens based on these apertures using the menu items shown below: 
 

 
 
First, select “Remove All Vignetting,” which deletes any pre-defined vignetting parameters that were 
previously set in the lens. Next, selet “Set Vignetting Data” to have CODE V iteratively search to find and 
store the rays that encounter the edges of the limiting lens apertures and aperture stop for use in future 
analyses. Data will be generated in the “Command Window” that describes the changes being made to the 
“Specification Data” of the lens. Specifically, the vignetting factors have been defined for each field by 
specifying the “upper” and “lower” extent of the relative pupil radius in both the “x” and “y” axes. 
 

 
 

Now examine the “Lens Data Manager” window to see a description of the lens prescription. Boxes with 
“v” denote parameters that are currently defined as “variables” for optimization. “s” indicates a “solve” 
parameter. In this lens, right mouse click on the grey box with the “s,” and highlight “Solve” to show what 
type of solve has been defined for this parameter. 
 
A “Paraxial Image Distance Solve”, PIM, has been defined for the thickness preceding the image surface. 
This “solve” tells CODE V to use paraxial ray analysis to determine the image distance required to locate 
the paraxial image.  It is historically useful to use PIM to determine the image location, especially during 
the early optimization stages of a lens.s3 
 
Experiment with the “GUI” interface by right mouse clicking on the various boxes in the “Lens Data 
Manager” window to see what data manipulation options are available to you for these lens parameters. 
Keep an eye on the data being generated and displayed in the “Command Window” as you use the “GUI” 
menus. This window will show you the specific CODE V mnemonic commands used to implement the 
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feature/analysis that been generated via the GUI. This will be useful later in this course as you develop 
customized “macros” or groups of commands to simplify your optical design/analysis tasks. 
 

 
 
 
Other useful menus… 
CODE V allows you to analyze the through focus performance of a system. This feature is implemented by 
specifying the number of through focus positions (up to 18), the first focus position, and the focus 
increment.  From the Lens menu select System Data… and scroll down to select one of the Advanced 
options, Through Focus: 
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Generate a Design Project Report 
 
You will be using the triplet lens that you’ve just modified to generate various graphical and 
text/tabular data for this lens for your design project report.  
 
First, give a new title to your lens. Save the lens prescription as a sequence file. 
 
Include the following data, graphical and text/tabular in your design project report. Comment as you see fit 
on the various plots, graphs, data, tables, etc., that comprise your report, and note how you generated the 
requested data. All of the graphics and text/tabular output are available via the GUI menus or command 
mode (more on command mode as we progress later in this course).  Experiment, explore, and don’t be 
afraid to try different things or refer to the Help menu in CODE V. 
 
Graphics: 

• Lens layout, 2-dimensional with the following parameters: 
o Show the lens surface numbers 
o Show the lens element numbers 

• Lens layout, 3-dimensional 
o Show with translucent surfaces 

• Transverse Ray Aberration Diagram 
o Set plotting scale to 0.4 mm 

• Ray Aberration OPD Diagram 
o Set plotting scale to 1 wave 

• Geometric Spot Diagram 
o Set plotting scale to 0.4 mm 
o Report the RMS spot size at each field 
o Report the 100% spot size at each field 
o Through focus at five defocus positions: 

  -0.50mm, -0.25mm, 0.00mm, +0.25mm, +0.50mm 
• Field Curves Diagram 

o Astigmatic Field Curves 
o Distortion Curve 
o Indicate in your report the maximum distortion at the edge of the field 

• Diffraction MTF Plot 
o Maximum spatial frequency: 50.0 lp/mm 
o Incremental spatial frequency: 5.0 lp/mm 
o Through focus at five defocus positions @ 20.0 lp/mm: 

  -0.50mm, -0.25mm, 0.00mm, +0.25mm, +0.50mm 
 
Text/Tabular Data 
 

• Lens prescription 
o Surface Data 
o Specification Data 
o Refractive Index Data 
o Solves 
o First-order Data 

• Third-order transverse ray aberration 
o Data for each surface 

• Fifth-order transverse ray (image) aberration 
o Data for each surface 

• Wavefront Analysis 
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Now evaluate the lens at the minimum RMS wavefront error position.  Report how much the focal plane 
has shifted from paraxial focus, and re-plot the following graphs: 
 

• Transverse Ray Aberration Diagram 
o Set plotting scale to 0.4mm 

• Ray Aberration OPD Diagram 
o Set plotting scale to 1 wave 

• Geometric Spot Diagram 
o Set plotting scale to 0.4mm 
o Report the RMS spot size at each field 
o Report the 100% spot size at each field 
o Through focus at five defocus positions: 

  -0.50mm, -0.25mm, 0.00mm, +0.25mm, +0.50mm 
• Diffraction MTF Plot 

o Through focus at five defocus positions @ 20.0 lp/mm: 
  -0.50mm, -0.25mm, 0.00mm, +0.25mm, +0.50mm 

Questions: 
 

• How has the Tranverse Ray Aberration Diagram changed when focus is shifted to the minimum 
RMS wavefront error position from the paraxial focus position? 

• How has the Through Focus Spot Diagram changed when focus is shifted to the minimum RMS 
wavefront error position from the paraxial focus position? 

• Based on your knowledge of third-order aberrations what third order aberration dominates the off-
axis image performance? How did you draw this conclusion? 

 
The report should be presented in an orderly fashion with the graphical and text/tabular data clearly 
indicated and labeled. 


